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Attention :
1. HYCON Technology Corp. reserves the right to change the content of this datasheet without further
notice. For most up-to-date information, please constantly visit our website:

http://www.hycontek.com .

2. HYCON Technology Corp. is not responsible for problems caused by figures or application circuits
narrated herein whose related industrial properties belong to third parties.

3.  Specifications of any HYCON Technology Corp. products detailed or contained herein stipulate the
performance, characteristics, and functions of the specified products in the independent state. We
does not guarantee of the performance, characteristics, and functions of the specified products as
placed in the customer’s products or equipment. Constant and sufficient verification and evaluation
is highly advised.

4. Please note the operating conditions of input voltage, output voltage and load current and ensure
the IC internal power consumption does not exceed that of package tolerance. HYCON Technology
Corp. assumes no responsibility for equipment failures that resulted from using products at values
that exceed, even momentarily, rated values listed in products specifications of HYCON products
specified herein.

5.  Notwithstanding this product has built-in ESD protection circuit, please do not exert excessive static
electricity to protection circuit.

6.  Products specified or contained herein cannot be employed in applications which require extremely
high levels of reliability, such as device or equipment affecting the human body, health/medical
equipments, security systems, or any apparatus installed in aircrafts and other vehicles.

7. Despite the fact that HYCON Technology Corp. endeavors to enhance product quality as well as
reliability in every possible way, failure or malfunction of semiconductor products may happen.
Hence, users are strongly recommended to comply with safety design including redundancy and
fire-precaution equipments to prevent any accidents and fires that may follow.

8.  Use of the information described herein for other purposes and/or reproduction or copying without

the permission of HYCON Technology Corp. is strictly prohibited.

© 2008-2010 HYCON Technology Corp APD-HYIDE001-V03_HYIDE SUM_EN —page 3
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1. HY-IDE Overview

1.1 Introduction

To facilitate the process of product development, HY-IDE development environment is provided
to deploy HYCON's full range of MCUs. Customers can implement the end-product’s in-circuit

emulation on this platform and program the code onto HY series’ OTP products.

1.2 HY-IDE Installation and System Requirement

The minimum requirement of system configuration to operate HY-IDE :
€ PC hardware request
PC compatible machine with PENTIUM® CPU
128 MB Memory (256MB is recommended )
10 GB Hard Disk Space
¢ OS
Windows 98SE
Windows 2000
Windows XP
Windows Vista
Windows 7
€ Applicable interface
USB Port

1.3 Installation and Uninstallation
1.3.1. Installation
Note that some Windows operating system may request the HY-IDE to be installed in the
Supervisor Privilege.
® [nsert the HY-IDE CD into the CD ROM drive and find the file in the CD ROM or file to
execute Setup.exe.

® Following the dialog step by step to continue setup procedures. As shown in
® Figure 1-1.

® First-time installation must initiate USB driver program, the setup procedures are as

Figure 1-2 shown.

© 2008-2010 HYCON Technology Corp APD-HYIDE001-V03_HYIDE SUM_EN —page 4
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1% HyIDEV11 - InstaliShield Wizard

1§ HyIDEV11 - InstallShicld Wizard r§

welcome to the InstallShield wizard for Custom Setup ‘
HyIDEV11 Select the program features you want installed,
The InstaliShisld(R) Wizard will install HyIDEY11 on your Click on an icon in the list below to change how a feature is installed.

computer. To continue, click Next. . 7 - Feature Description

WARNING: This program is protected by copyright law and
international treaties.,

Install to:

[ Tees Concel pece [ <geck [ bet> [ concel |

15 HyIDEY11 - InstaliShield Wizerd

i HyIDEV11 - InstallShield Wizard

License Agreement ‘ 55 Ready to Install the Program
Please read the Following license agreement carefully. ‘ The wizard is ready to begin installation. ‘

T If you want to review or change any of your installation settings, click Back. Click Cancel to
To add your own license text to this dialog, specify your icense agreement file in the Dilog oxk the wizard,

leditor, Current Settings:

1. Mavigate to the User Interface view. Setup Type:

2. Select the LicenseAgreement dislog.

3. Choose to edit the dialog layout.

4. Once in the Dialog editor, select the Memo ScrollableText contral,

S, Set FileName to the name of your license agreement RTF file. Destination Folder:

|After you buld your release, your license text wil be displayed in the License Agreement dislog. CilProgram Files|HyIDE{HYIDEY

User Information:
+ Ihmh
(®¥ accept the tarms inthe kcenss LA
- 3 Company: Hycon
(1 do not accept the terms in the license agreement
[ <Back  J|__met> ][ Cancel <Back | Instal i Cancel

i% HyIDEV11 - InstallShield Wizard

1 HyIDEV11 - InstallShield Wizard

Customer Information Installing HyIDEV11 \ ‘
Please enter your information, ‘ [ The program features you selected are being installed. ‘
User Narne: _A@|  Please wait while the InstallShield Wizard installs HyIDEV11. This may take
[Lhmhuma several minutes,

Organization: Status:
| Hycon|
(FERNNRNANRNANRNANRANARARNRANRRNN )

Install this application for:
(® anyone who uses this computer (all users)
O Only for me (user)

< Back Next > Canc

15 HyIDEY11 - InstaliShield Wizard

15 HyIDEV11 - InstallShield Wizard 3]
Destination Folder

InstallShield Wizard Completed
Click Mext ta install to this folder, or dlick Change bo install to a different Folder.

(= Install HyIDEV11 to:

C:{Program Files\HyIDE\HyIDE} gklﬁilﬁixlﬁ\::fd futcmfully installed HyIDEV11,
Launch the program

<gack | mext> | Cancel

Figure 1-1

© 2008-2010 HYCON Technology Corp

APD-HYIDE001-V03_HYIDE SUM_EN —page 5
www.hycontek.com



HY-IDE Software User’s Manual

HYCGON

HYCON TECHNOLOGY

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

This wizard helps you install software for;

USE Device

L'_) If your hardware came with an installation CD
&2 or floppy disk, insert it now.

“wihat do you want the wizard to do?

@ install the sofhware sutomatically [Recommendedf

() Install from a list or zpecific location [Advanced)

Click Next to continue:

P

Install from a list or specific
location(Advanced)

Found New Hardware Wizard

Please choose your search and installation options.

(2 Search for the best driver in these locations.

Use the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best diiver found will be installed.

[ Search removable media (floppy, CD-AOM...]
Include this lacation in the search:
C:\Program Files\HylDE\Driver

) Don't search. | wil choose the driver to install.

Choase this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ <Back ][ New> | [ cancel |

21X

Select the Folder that contains drivers for your hardware,

Browse For Folder

=l [Z) Pragram Files

|=) Common Files

|2 ComPlus Applications

|2 ConnectionManager

I HyIDE

(=]

# =) HyIDE

1) Inkel

+

£

To view any subfolders, click a plus sign above,

Hardware Installation

L E The saftware pou are installing for this hardware:
L]
HyconUSE IDE Device

haz not passed Windows Logo testing to verify its compatibility
with Yfindowes XP. [Tell me why this testing is important. ]

C your i of this may impair
or destabilize the conect operation of your system
either inmediately or in the future. Microsoft strongly
recommends that you stop this installation now and

tact the h vendor for soft that has
paszed Windows Logo testing.

r'd

[ Lontinue Anpway ] | STOP Installation |

Found New Harndware Wizard

Please wait while the wizard installs the software. ..

% Hycon-USE IDE Device

= ey

Satting a system restore paint and backing up old files in
case paur system nesds ko be restared in the future.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

% Hycon-USE IDE Device

Click. Finish to close the wizard.

Figure 1-2

© 2008-2010 HYCON Technology Corp
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1.3.2. Uninstallation
Please remove the file “HyIDEV11” in"Add/Remove” under Control Panel.

1.4 Register

1. Customers use ICE hardware emulation or OTP programming for the first time.
2. If the dialog appeared or abnormal IDE crash occurred, customers must conduct re-register

action.

@ HyIDE has not been Regisiter! |

Figure 1-3
Register Procedures
1. Please check the HyIDE Machine Number (HyIDE Code) on the parcel and send the number by
e-mail or on-line register. HYCON will send back another customer register code to you.
Connect the HyIDE Control Board to PC through USB interface.
2. Execute HyIDEV10 software (HylIDE.exe). Go to”"Option” and press’Register”.

3. Fillin the customer code in “Register Number” and click"Write” to start.

S Interface Setup E|@J® S Interface Setup g@@
Interface Setup Build Options Interface Setup Build Options
Int Setup ICE Test Int Setup ICE Test
Register Register
HylDE Machine Number HylDE Machine Number
00000009 00000009
Register Number Register Number
| . [FD02FD34)
Write Write
Close

Figure 1-4

4. |If the process is successful, a dialog will be shown.

Information

Figure 1-5

5. If the process is fail, a dialog will be shown as Figure 1-6.

© 2008-2010 HYCON Technology Corp APD-HYIDE001-V03_HYIDE SUM_EN —page 7
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@ HwIDE has not been Fegisiter! ||

Figure 1-6

6. Once the register is succeeded, Customers do not have to worry that other numbers may be

written into the “Register Number”.
1.5 Use Demo Code to Guide User Manual

» Start KitchFor11P13.asm

» Set the file as assembly main file

» Assembly start to progress program debug

S H¥IDELDD - Mode:[Edit] »1 .08
Edit Seamch Wiew AssmbleszEun

Wew (M) Cel+ M
OpeniCy Chl+0
Bave (@) Chl+d
Have Lz p

Jave All Open Demo Code
Closs File .
Cloz: 411

Cipen Project

Bave Project

Fead From Flash Memorys

ExdtiCh) i+

© 2008-2010 HYCON Technology Corp
www.hycontek.com

Open

?IX

Look in: | I3 KitchenScale

> & & cFE-

) [Z] ancC
@- [Z] aDccaL
My Recent [Z] Display Vs .
Doeuments | 2] 1ntapc L Choose kitchFor11P13.asm
?1' @ Interrupk _—
IE] Keyscan ///
Dk | @ IR
. [ LoD
.’] E] MainPro
[Z] Math
My Documents 2] szacux
- [£] spr 4 h
3113 E] subroutine LOpen Demo CodeJ
tdy Computer @ Syslni
My NetwarkFie pame: [kitchFort1P13 =
Jaces
Files of twpe: |".asm ﬂ Cancel
Figure 1-7
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S HyIDELDD - Mode:[Edit] v1.08 Chip = HY - 11P13 (4K) ICE Inteface = USB Project =
Fil= Edit Search View Assmble&Ruon Options  Windows

3 = i g

Set main file & ke - [BX]
=Ea 2 o @

[KkeheorT P13

1 Cptionis Wi ~
AgsemblefzRun ( Emulation } F4 ; SPICNT : B BISPIIRIE
Assenble CHlFILO ;. SPICNT=0=> SPIBUF&YBit7=1E# , SPIBUFAYBt 7 =0 8

; SPICNT = | => SPIBUF = $&FERAM Address 3 Low byte --> FSROL
SPICNT =2 => SPIBUF = }8TERAM Address 8 High byte --> FSROH
SPICNT » 2 —> % $ETERAM Address SME{TRRESIE

Set Mode ' s SPICNTA a8 255

;& CSPIN 6 18%0 38 (HO#S 1 E35RR SPICNT

org 0000
_> jmp ProBegin

nop

jmp 0

org 0004h

Include Interrupt.asm

[ Make sure is
ProBegin:
include SysIni.asm connectefl

mvl  OEOh [

mvi SPIINDEXL,F,ACCE Display main j

i Rl filename
mvl  13h  ;EEEUES
mvf  OF5h,F,ACCE 7
. P i s
11 Modified
- \Progran pues\:;ymx\uymn\Dmﬁc{\mu:hengcala\mncmoruna,es.. ,T%ﬂhad&s\m = 0x2946
Figure 1-8

%) HyIDE - Emulation  Chip = HY - 11P13 (4K) ICE Inteface = USB Project = EFEX)

Edit/Debug

File Edit Search View Asssmble&Run Options  Windows SRAM Recond
B3 s @ = # YT D PP B

Bla 1@ o0&

KitchForl IP13.asm | INTERRUPT ASM | SPLASM | INTADC ASM | SYSINLASM | KEYSCAN A 4| »

Options  Windows

- ; sPIcNT : $BUTE[seTRYEYS j
S ; SPICNT = 0 ==> SPIBUFHYBit 7 = 1 i& , SPIBU
- ; SEICNT = 1 ==> SPIBUF = {S7ERAM Address BY
- ; SEICNT = 2 ==> SPIBUF = $ESERAM Address AY
Access to debug - H SPICNT > 2 ==> 2} {§FEraM address E{TIEER
[ picture j\ - ; sPIcNTT OIS 255

- ; %cs pIN BH1EE0 T pHOENL € EER sPICNT

— org 0000h

nop
jmp 0O
= org 0004h

= Include Interrupt.asm

H
= ProBegin:
= include SysIni.asm

mvl OEDh

mvi SPIINDEXL, F, ACCE
- s =============1 RI[FEER E5F ﬂ
Lime: 11 Sge:27k ! 4K Total Code Line =2715

main: C:\Program Files\HyIDE\HvIDE\])emCode\Rit.cbenS{ ICE Connect Checksum = 0xZ346

Figure 1-9
Any editor can be used to edit Source Code, as long as it can be stored as ASCIl Code format.

Debug and edit function will be elaborated in next Chapter.

© 2008-2010 HYCON Technology Corp APD-HYIDE001-V03_HYIDE SUM_EN —page 9
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1.6 Demo Code Operaiton

®  After executing HYIDE software installation, a Demo code is provided for user’s reference under:
C:\Program Files\HyIDE\HyIDE\DemoCode.

® Related document of Demo Code is provided on: http://www.hycontek.com/page2.htm| Product

Application Notes. Below listed corresponding documents for reference:

m  Kitchen Scale: APD-SD18007 (Kitchen Scale Application Note)

B Kitchen Scale-SINC3: APD-SD18003 (50/60Hz Rejection Solution)

B HY11P32 Demo code: APD-SD18004 (Auto On Measurement Application)

© 2008-2010 HYCON Technology Corp
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2. HY-IDE Interface Description
2.1 HY-IDE Edit Interface

[ IDE Version j [ IC Part No. j IDE Interface

Project Name

%) HyIDE100 - Mode:[Edit] v1.08  Chip =HY - 11P13 (4K) ICE Inteface =USB Project= [ |(B1|[X]

File Edit Heach View Aszemble&Run
. j_."- ; = 1 @
= a g o &
[ KitehForl IP13 asm |
e , =
: SPICNT : HelB|SPIIeL R
: SPICNT =0 == SPIRUF&YBit7=138, SPIRUFRIBt 7=08
; SPICNT = 1 => SPIBUF =$87FRAM Address 8] Low byte --> FSROL
; SPICNT =2 => SPIBUF = {§ERAM Address &7 High byte --> FSROH
; SPICNT = 2 => ¥} $8TERAM Address JETESENF
s SPICN T~ AJ #8518 255
; BCS PIN 851990 3 (HO¥S | E75B% SPICNT
org 0000R
mp ProBegin
nop
mp 0
org 0004k
Include Interrupt.asm
FProBegin:
mcluode Swyslniasm
mvl OEOh v
< >
1:1 Modifed &
C:%WProgram Files‘-.Hy]IDE\HyIDE\DEMDCDd.e\RitchenScale\Kitcth ICE Connect Checksum = 0OxZ346

Main filename connection [ Checksum after ]
status assembly
Figure 2-1
© 2008-2010 HYCON Technology Corp APD-HYIDE001-VO3_HYIDE SUM_EN —page 11
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s MNew

Create a new file

= Open

Open an existing file

s Close

Close the current active file

2.1.1 Edit Window

>

]

Open L=

Open an existing file.

Label Setting

Set label. When open too many files, this icon helps to return to the label setting place
quickly.

Jump to Label 3

Jump to where to label has been placed.

Find <,

Search the entered word.

Search the specified word. « ]

Switch Display Window

When too many files are opened, this icon helps to command file switching.
Edit &
Only editor is executed. It will not get into program debug status.

The information dialog may pop up after edit accomplished.

S Meszsage
C:'-.Pruqram Files\HyIDE\HyIDEADemoCode\KitchenScale\KitchFor1 1P13.asm ....... Compiler ...couniemnees

C:\Program Files\HylDE\HyIDE\DemoCode\KitchenScale\KitchFor11P13.asm ....... Compiler complete

2.1.2 File Menu

S Hy¥IDELDD - Mode:[Edit] »1 .08
Edit Bearch View LzembledFun

Hew (I I
Cpeni ChlO
Save (R Chlts
Bave Lz

Bave A

Cloz File

Clom AL

Cpen Project
Bave Project

Fead From Flazsh Memory

Bty Cl+i
Figure 2-2

© 2008-2010 HYCON Technology Corp APD-HYIDEO01-V03_HYIDE SUM_EN —page 12
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>  New > Create a new file.
»  Open = Open an existing file.
>  Save > Write the active window data to the active file.
»  Save As > Write the active window data to the specified file.
»  Save All > Write all windows data to the corresponding opened files.
»  Open Project = Project includes IC part no., IDE interface, Edit main filename, Active

opened status, and Checksum. Project status will be loaded in after the project is opened.

\4

Save Project > Write the active project to the active project file.

»  Close - Close the current active HyIDE program.

2.1.3 Edit Menu

¥IDE1DD - Mode:[Edit] 1.
IS Search  View  Assembl

Tndo (@) Ctil+Z
| CutaD Ctl+E
| CopwiC) Ctrl+C
Paste () Ctrl+¥
Belect AL
Figure 2-3

Under editing the file:

Undo - Cancel the previous editing operation.
Cut - Remove the selected lines from the file.
Copy - Place a copy of the selected lines.

Paste - Paste the copy lines to the present insertion point.

YV V V V V

All - Select all lines in the active file.

2.1.4 View Menu

Mode:[Edit] »1 .08 Chip = HY
AgembledzFEun
Edit Alt+l

= Mezmge 1
11
=] i
3] i
S. —1

Hext File Llt+Eight f
-ﬁ Prewvionz File Alt+Left

Figure 2-4
© 2008-2010 HYCON Technology Corp APD-HYIDEO01-V03_HYIDE SUM_EN —page 13
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»  EditWindow - Appoint the edit window as the present active window.
>  Nextfile - Appoint the next file as the present active window.

»  Previous file > Appoint the previous file as the present active window.

2.1.5 Edit & Execution Menu

Azemble CHl+F10
Set Main File

Het Mode 4

ML o oo L

Figure 2-5
>  Edit & Execution - Edit Source Code and execute program debug mode.
Edit > Only program is edited, program debug is not executed. This assembler will not
generate error message according to IC part no. Error message will show up when the
lines is error. It is usually used in generating OBJ Code (Object).
»  Set Edit Main File > Set the file as edit main file. Files will be named after compiler
generated file name, such as Hex, MAP, ASC---etc.

»  Debug = Debug through software or hardware is selective.

2.1.6 Options Menu

S Interface Setup EJ @ E'

Interface Setup Build Options
Int Setup ICE Test
Register

Chip Select

Language English =
Hardware |nterface
* |nterface Mode

USe -

IDE Mode
* emulate and Debug

i~ Programmer

Program Memary Select

[~ |

Cloze |

Figure 2-6

© 2008-2010 HYCON Technology Corp APD-HYIDE001-V03_HYIDE SUM_EN —page 14
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(1)

There are five options:

Interface Setting

S Interface Setup

Interface Setup

B=1E3

Build Options

Int Setup ICE Test

Register
Chip Select

Language Englizh ~

Hardware Interface
* Interface Mode

use h

IDE Mode
" emulate and Debug

™ Programmer

Program Memory Select

[~ |

Cloze |

Figure 2-7

» IC option: Select IC part no. Compiler will assemble the selected part no.’s program file.

It will determine whether there is any misuse or non-existing Register or SRAM, or has

the program exceeded the ROM Size.

» Language option: English and Chinese interface are selectable.
» Communication interface option: Select IDE communication interface.

» Mode option: Two choices, Emulate and debug and program.

(2) Edit Item

© 2008-2010 HYCON Technology Corp
www.hycontek.com

S Interface Setup B@E|

Interface Setup Build Options
Int Setup ICE Test
Register

Generate Files Iv Enable Tool Bar

W Hex file Font

M S No Use Area Fil
[ List file & 0
I~ ASCI file  FF

Iv Smart Campiler

[~ Program Protect

Stack Option Compiler Select

-
[™ Stack Over resel

-~

Input Program Times
[~ Enable Program Times

Cloze |

Figure 2-8
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YV V V V

Assembler generated extension: it is selectable to produce below file format.

1. binary file : Hex

2. objfile : obj

3. Listfile : Ist

4. ADCII file : asc

Stack operation: Choose to replace the program after stack overflow. When this option
is chosen, Compiler will add to Hex, it will be programmed in to OTP.

Program number of times limit: Please refer to the program Chapter.

Font option: Choose editor’s fonts.

Fill unused zone: Fill the unused zone with 0x0000 or OXFFFF in the program.
Simplified assemble: Simplified assemble function is selectable. When JMP or CALL is
smaller than 2K, it will automatically transform to RJ or RCALL. If the arguments of
CALL are set, it will not transform to RCALL.

Program protection: Please refer to the program Chapter.

(3) Interrupt Setting

E Interface Setup g@@
Interface Setup Build Options
Int Setup ICE Test

Register

[ STOP“When O Stack Watch Address

[ ‘“Watch enable Bit0

[~ ‘watch enable Bitl
[~ “Walch enable Bit2
[ Walch enable Bit3 Wl Pt
[ Watch enable Bitd
[ Watch enable Bit5
[ Watch enable BitE
[ ‘“Watch enable Bit?

Close |

Figure 2-9

» Stop operation when Stack overflow: IDE will stop when Stack overflow.

» Monitor address: Select the monitored Register or RAM. The program will stop when
the program executed RAM or Register value equals to the monitored Data.

» Monitor Data: Monitor value is set when the monitor Data is filled up.

» Monitor RAM bit: Monitor function will be activated if the monitor bit is marked on. The
program will stop when the bit of Data value equals to the marked on bit.

© 2008-2010 HYCON Technology Corp APD-HYIDE001-VO3_HYIDE SUM_EN —page 16
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(4) ICE Test
S Interface Setup E]E|E|
Interface Setup Build Options
Int Setup ICE Test
Register
SRAM Data
Address VPP
Wiite Data v
Read Data
CKWPR
Write Read 4
VvCC
Program ROM Data

T
Address v
Wwiite Data EKWED

Read Data

Wirite: Read CrALL
_wite | Read |

Cloze |

Figure 2-10

2.1.7 Window
The window can be displayed horizontally or vertically.

oA

HyIDEL0O - Mode:[Edif] ¥1.08  Chip —HY - 11P13 (4K) ICE Inteface — USB Project— [ |[01|[X)
File Edit Seamch View Assembled:Fun Crptions

Tl ind o
Tile Horizontally A1t Dioven
Tile Werticlly A1HTIp

Figure 2-11

2.1.8 Program Structure
Before editing new program, user must select IC part number through interface setup;

Different IC will have different Instruction Set, according to IC part number definition; it is classified as
HO8A and HO8B instruction set;

User can refer to the appendix software demo code, Chapter 1.6 gives illustration of demo code usage.
Users can refer to following program structure to start writing program. Basic structure description is

listed as below:

®  Program Name Definition as: ***.ASM
®  Register Name or RAM Definition as: ***.INC
® Many program contents are listed below:
®  “Main.asm”, “Initial.asm”, “Interrupt.asm”, “Sub.asm”, “Mian.inc”, “H08.inc”

®  “Main.asm” structure: ;Program name can be any name
ORG OOH ;Declare program start
JMP BEGIN ;Jump to main program
ORG 04H ;Declare interrupt flag address
Include Interrupt.asm ;Cite "Interrupt.asm” interrupt vice program ;
© 2008-2010 HYCON Technology Corp APD-HYIDE001-VO3_HYIDE SUM_EN —page 17
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:Include file max. 100

BEGIN: ;Start Main program. Label name definition can be any word
Include Initial.asm ;Cite "Initial.asm” hardware initial vice program

JMP T1 ;Jump to T1 vice program

T1:

NOP

Include  Sub.asm ;Cite "Sub.asm” vice program

Include  HO08.inc ;HY11P series special register name, address definition
Include  Main.inc ;RAM name, address definition

END ;Program end

Reference Document:
IP User Manual: User’s Guide

Instruction Set User Manual: HO8A Instruction Set Manual or HO8B Instruction Set Manual

HYIDE Complier User Manual: HY-MCU COMPILER

2.1.9 Self-Defined Instruction

® HYIDE included user self-defined instruction function since V1.6. This function provides user to
self-define HY11P series instruction as the familiar MCU instructions.
®  Usage description:

1.  All self-defined instruction function is installed under: Inst.txt file. It is separately as two rows.
The first instruction (first row) of every row is origin HYCON instruction name; users can not
make amendment to it. The second instruction (second row) is "User" self-defined instruction
name.

2. First and second instruction can only be separated by space, multi-space or Tab.

3. Second instruction can be followed by semicolon (;) as remark.

4.  Second instruction name can be the same as the first one.

5.  The name of second instruction can not be defined as any of HYCON origin instruction name
except the instruction in the same row. Otherwise, it is deemed as invalid and will adopt the
origin instruction name to compile program.

6.  After users self-define the second instruction name, the first or second instruction name can be
used when program compiling.

7. Everyrow can only has one self-defined instruction name, any repeated instruction name will
be deemed as invalid.

® Example:
JMP  JUMP JMM JPP JU ;X error define method

® Repeated defined instruction or self-define instruction will be deemed as invalid.
Example:
JMP  JUMP
JMP JPP ;X instruction name redefine. JUMP will be deemed as invalid instruction, only JPP is
valid.
JPP JU ;X cannot use self-defined name to redefine
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JMP JN ;X cannot be defined as HYCON origin existed instruction name
Correct definition is:
JMP  JUMP

3. HY-IDE Debug Interface

It can be classified into hardware debug and software debug.
® Hardware debug

The indication column is blue
® Software debug

The indication column is green

E HyIDE - Emulation Chip =HY - 11F13 (4K) ICE Inteface = USB Project=
File Edit Search View AssemblefFRun Pogoonmner Options Windows SRAM Record

...... il pb %

BT EsPIRI BN E j
;SPICNT: - H SPICHNT = 0 ==> gPIBUFHY
; SPIC - i SPICNT = 1 ==> SPIBUF =
- E SPICNT = 2 ==> 8PIEBUF =
- ; SPICNT > 2 ==> B FHER
= ; sPICNTRA[FEIE 255 ~|
L Size:27k / 4K Total Code Line = 2715

e Y T
. [B[X| 35Dais Memory = [=1E3
o |z lzlals|s |7 |8 |o |als |c |p [Ea

Qoo R.J 8h B oo

01 .\MUUBS - - 000000 - 0000 - 03 2
0zo|7B 00 18 00 0O - 00 OO - AS 01 0O 10 0O -
USDID 01 00 00 00 Q0 00 00 = OO0 Q0 Q0 00 00 0
040|000 00 0O FF 00 00 DF 0O 00 FF FF FF FF -
osal - FR 0O 00 00 74 63 74 3E 7B 10 00 00 00 O
00 FF\- - - |- |- - - -/ -]/ -/ -s00®

. —
3 11P13Special Register - [O|[X] 3By WAICH =] E3
[TNDG. M[D55 J=10_] [Frogrm Cownter 0| AW Name |Addr [Hex(H > I|Bin/Refered Symbef &

[INDI M[085]=10 |[WREG A5 | [Cycle: 0000000

Byte o
INDFO | FOINCD PODECO FRINCO FLUSWD INBFI | POINCI f

FLUSW] WWREG BSE ADCFH ADCEM ADCRL TMAR

= A5 01 juli] i} oo ui]
PWMR SSPBUF LCDO LCDl  LCD2  LCD3  LCDd
FF FF 00 74 &3 74 3E
LCD7 LCD8  LCD9 v
£ > . M

main: C:\Program Piles\l{ym!\HyIDE\BmCoaa\Kitchenscnla\Hir.ehForl.lPla.asl ICE Connect Checksum = 0x2946 .
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3.1 Fast Execution
[ G L B I U S S B A U B> A
Fast Window Switch
(2) Switch to Edit window [ (3) Switch to Source window
R Eait _Ex R Ssemeecete. | [BX]
=8B a A o & KitchForl IP13 asm | INTERRUPT.ASM | SPLASM | INTADC.A 4| ¥ |
l — - ; BPICNT : ErE|=zprghBErE ﬂ
i = - SEICHNT = 0 ==> SPIBUFHY
i SPICNT : SBRRISP RN B I S
. SPICNT =0=—= SPIBUF#YBit7 =158, SPIBL o . _
;  SPICNT =1=> SPIBUF = }55ERAM Address : PRLCNT = 2 mm= BRIBUF =
SPICNT =2 —> SPIBUF = J&5FRAM Address ¥ B SPICNT > 2 ==> Bf fEER
< | > - ; SPICHT-~O]EEi® 255 i
11 Modified Line: 11 Size: 27k / 4K Total Code Line = 2715
- - 1['1\. 0 - ﬁ
(4) Switch to Hex window "™ (5) Switch to Ram window
& Program Memory _@[XJ Data Memo _@E]
addr instruction - z |3 (2|5 |6 |7 |58 |2 | |B |C |D |[E~
noan : =|=|=|=|=|=|=|=|=|=|=|=|:F
0001 0000 HoP oin|5L 00 85 - - - OO0 00 0O - 00 00 - 0% 2
000z 7FFD RJ TFDh ozo|7E 00 16 00/00) - (00 00 - A5 01 0010 00 -
ooos 0000 NoF 03000 01 000000 00 00 00 - 00 00 0000000
o004 pOOF  MVEF Fh (0an|00) 4000 00| FF 00|00 DF 00|00 FF FF FF FF| -
0005 FOFF  NOEF FFh oso| - |FFloo|oo oo/ 7463 72 3E 7B 10 00 00 00 0
0006 DOLO MVFF 10h 00 FF| = | = | < <<= << -/<=[< solo®
D007 FOFE HNOPF FEh . < ) 3
[nEulniu] atuit B | rATTTATH 44 1- — Ba—r'kl] BaI'kl
(6) Switch to Reg window ¢ (7) Switch to Watch window
& 11P135pecial Register @@ ]
[THDO: M54 J=10_| [Program Couner: 0| Mae  [addr  |Hex(H-->I|BinRefered Symbe &
[TNDL: M[085 =10 |[WREG A5 | [Cycle: DODOOOOE |
Byte L

INDFO  POINCO PODECO PRIMCO PLUSWO INDF1  POINCL B

FLUSW]1 WEEG EiR ADCFH ADCEM ADCEL TMAR

= 45 01 oo oo a0 oo
PWHME SSFEUF  LCDO LCD LCD2 LCL3 LCD4
FF FF a0 T8 63 T4 3E
LCD7 LCDE LCD& w
< | >
Fast Debug

™
(1) Step back
a
(2) Trace (Enter into Macro/vice program) &
. . s
(3) Step over (Not enter into Macro/vice program)
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(4)
(5)
(6)
(7)
(8)
(9)

e

[Free RUN

\

T
LStep Over {P Run Fa

[Trace

\

A=
LStep Back ‘T

/Stack Out

skip cail (¥

Execute (Free RUN) [
Pause OO

Continue [L*

Program replace '

Back to edit mode 2

Chip - HY - 11P13

Lzemble&Eun

A, | e—

- —
//{Contlnue [>[>7

‘\‘Step Ohver Fa////

e A /,/{Stop nnj

~

&

[Tl

= ~

potack Ot )
{r?‘ tepBack _ B

Continuad” //////
Pl

\
\
=

Program ReseI'EJ

1 Program Ress
£ Edit Mode

Zet Break Point

Figure 3-1

Two methods to set or remove interrupt:

1. Use mouse to select interrupt place in program code window or machine code window,
press “F2” button to set to remove interrupt.
2. Use mouse to select interrupt place in program code window or machine code window, double
click the left key to set or remove interrupt
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=
KitchForllPB.asmIINTERRUPT,ASM addr code instruction -
— —]03ZF  669F MVE 9Fh, 1, 0 M(9F)=0
g 0330 9ES59 BaF 59k, 7, 0 M(52)=T1
- |; sPIcuT o HERITE(aP 0331 GBCaAS BCF a8h, 6, 0  M(a8)=3
=i SEICNT = 0332 BEAS BOF ABh, 7, 0  M(aB)=3-
- ; BEICHT = 0233 0&ceE MVL cEh
c"mw - ; SPICHNT = 0334 a6CDh MVFE Chh, 1, 0O M{CDY=0
toset TS > |; SPICNT = 0235 O0OCEBEE CLLEF E8h, O M(ES)=0
interval = SPTCNT R ATHEIS 25 0336 9EZ3 BSF 23h, 7, O M(23)fﬂ
) - |;#=cs pTv ghiggo = |0337  80DZ EBOF DZh, 0, O M(DZ)=1l
\__section I & |0333  DEED ML EOh
! T~ 0339 GE6FS MVF Foh, 1, O M{F3)=F
- = e 0334 0613 MVL 13h
BEAIRRA .  |033E  66F5 MUF FSh, 1, 0 M(F5)=0
nop 0330 0601 MYL 1h
jmp O 033D 6E6F4 MVF Fih, 1, 0 M(F4)=0
= org 0004k 033E  ALZD ETSZ 2ph, 5, 0 M{ZD)=0
- Include In 0233F 905A E&F Sah, 0, 0  M(5a)=1l
- |, 0340 BAZD ETSS 2ph, 5, 0 M{ZD)=0
- |eroBegin: 0341 BO5a4 BOF S&h, 0, 0  M(5a)=1l
. 0342  A6Ad ETSZ adh, 3, 0  M(a4)=0
- include Ay
| 0343  7B25 RJ 325h
g 0344 AEDZ BETSZ DZh, 7, 0  M(DZ)=1l
* vl UEQR 0345  7BZD RJ 3zDh
mvE SPII 0346  AADZ BTEZ D2h, 5, 0  M{DZ)=1(
- je============§  |(0347 TAFZ RJ ZFzh
mvl 13h 0348 ABad4 EBTSZ a4h, 4, 0 M(ad)=0
v OFS 0249 7AF0 RJ 2F0h
vl ih 0344 ABAS ETSZ aBh, 4, 0 M(aB)=3:
- oral JO34B. 794B RJ 1aEBh
_ . D34c i A06D ETSZ 6Dh, 0, 0  M(&D)=8I
| ’ | lo34p 782ZF BT 2Fh |
Line: 19 Size: 2.7k / 4K Tots
Figure 3-2

3.2 RAM Window

alslelzlalslale[c o [e [F
= = = = = == === =10
Dio|5L 0085 - | - - DO|OD| 0D - OO OO - 0% ZE 7F
0zo0|7B 00 15 00 OO0 - 00 0O - A5 01 00 10 00 - -
030|000 01 00 00 0O 0O 00 0O - 00 0O OO0 0O OO0 00 00
Dap|00 40 00 00 FF 00 00 DF 00 00 FF FF FF FF - 30
D5o| - FF 00 00 00 74 63 74 3E 7B 10 00 00 00 03 -
Deo|00 FF - - - - - - - - - - - 8000 oo
o7olo0 00 oo - 1c o0 - oo OO OO - - - - - -
DE0| A5 A5 A5 A5 00 10 09 02 03 04 03 00 7B OO0 OO OO
bop|oo0 00 00 00 0O zo 43 03 00 00 0O OO0 0O OO0 OO OO
Dap|00 00 0O 00 0O 0O O1 0O 34 00 0O OO0 OO O7 EF DE
DED|75 DE 00 00 00 0O A0 FE OO0 OO 0O OO0 0O OO0 00 OO
oco|oo 0o oo oo o1 00 00 0O OO0 OO 0O OO0 SE OO0 OO OO
0Do|00 00 10 FD DB 79 DE D& 79 DE BE 79 DE 04 7L DE
DEO|EF 79 DE 8 79 DE OC 7A DE D4 79 DE 00 04 00 0O
OF0|0B 00 E7 79 00 0O FF 0O F7 00 00 00 85 00 54 00

Bank0 Bankl

Figure 3-3
After opening RAM window, Bank will show the volume of the selected IC. Every Bank has 256 byte.
BankO starts from 0x00 to OxFF. Bank1 starts from 0x100 to Ox1FF...etc.
If the address does not exist, it will display” -“.

If users intend to switch Bank display, use cursor to point to the desired Bank zone, and then click the
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left key of the mouse to confirm.

If Hint is set, the address will display numbers and will be underlined.

Notice: The Address 0x00 ~ OxOEof BankO is indirect addressing register, it cannot be revised
directly, the displayed value is not referable. If revise is required, please refer to Chapter 3.3:

Revise indirect addressing Data or Address.

Function Display
Click the mouse selection key (right key)

1)
2
3)
4)
()
(6)
(7
8
©)
(10)
(11)
(12)
Hint

Zet Mark

Zet Markfnew color)
Eeset Mark

Fest 411 Mark

set Hint
Feset Hint
Feset A1 Hint

Load BAM Data
Sawe RAM Data
Bave To excel
EaMBANED
ELMBANE]

Figure 3-4
Set Mark
Set Mark (new color)
Reset Mark
Reset All Mark
Set Hint
Reset Hint
Reset All Hint
Load RAM Data
Save RAM Data
Save To excel
RAMBANKO

Use DS defined SRAM; Hint will be automatically generated in corresponding window address. When

cursor point to the address, it will show the defined string.
Ex: Program definition SRAM

MEMAR 080h

MD1 DS 1
MD2 DS 1
MD3 DS 1
MDL1 DS 1
MDL2 DS 1
MDL3 DS 1
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MD4

S REG
r_ Len
SQRTmp
Temp

DS 5
DS 1
DS 1
DS 4
DS 16

After assembling, it will enter into debug status, displaying memory window.

When cursor points to 80h address, <80>:MD1 will be shown.

When cursor points to 86h address, <86>:MD4[0] will show up.

When cursor points to 87h address, <87>:MD4[1] will show up.

S Data Memory

3 |4

S e |7 |8 |2

L |[B |C |[Ir |E [F

a0

10

oz=0

TE| 00 ks

030

040

00 3nf 00

a50

- B 0o

os0

00 PR —

a7a

oo oo oo

as0

oon| tad

il ate)

<f= kD 1

OAad

o [

OEO

72 DE 00

aca

a0 oo aad

ano

oo oo 10

OEOQ

EF |79 DE

aFa

o3 0o E7

B

ankl

DDE— -

oo oo

oo oo m 63 m 0o oo

1

- oo oo

oo - oo
10 09 02

2943 03
oo o1 a0
00| L0 FE
oo oo oo
79| DE D3
DE OC 74
oo FF 00

aa

oo
a3
aa
34
oo
aa
e
LE
F7

oa

aa

ZE

oo
TF

ooloo - EDD 10 (]l

00 N OO0 00 00 00 o0 oo

00 00 00 00 00 00 00
|:u:||:u:| |:u:||:u:| DDFFFF - ﬂ

DDm—

a0 oo aad

oo
04
aa
aa
oo
aa
DE
g
oo

03
oa
oa
oo
oa
EE
79
oo

aa
aa
aa
oo
aa
=
IE
oo

7B
aa
aa
oo
SE
DE
aa
85

aa
aa
aw
oo
aa
()}
04
oo

oa
oa
EF
oo
oa
Th

oo

Sh

oo
oo
IE
oo

There are two ways to revise SRAM value:

Figure 3-5
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1. Point the cursor to the selected revised lines, click mouse’s left key and Key IN directly.

2. Point the cursor to the selected revised lines, double click the mouse’s left key, a window will

pop up as Figure 3-6 shown. Users can key in on keyboard or press the button by mouse.

| RAM Address |

Mouse Click

li

© 2008-2010 HYCON Technology Corp
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RAM Data

P
5|46
A

D|E

m (o |-

fEieighe" R

Figure 3-6

| KeyboardKey IN |
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3.3 Register Window

Indirect addressing 0
Data

-

Program
Counter

&3 11P138pecial Register

Indirect addressing O
Address
Indirect addressing 1
Address
Indirect addressing 1T —

Data T

[
(

~

(

J

[ Single Byte Register }*wm,

one Word composed \T"”"”

Register

(

( Display PAGE 1 Registerj"**—————

J

- {[HDOMDSA =10 ] [Progsam Cowier 0|

[INDL W UE5 Tyl |[WRES &5 | [Cysle: 0000O00E. |

HYGON
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Cycle Times

Byie

[NDFD | POINCO PODECO PRINCO PLUSWO

PLTISW1

INDF1

ADCEH ADCEM ADCEL
Jalu]

LDl
FF
LCD7 LCDE LCD®
on Jul} Jul}

POINC1 PODEC] PRINCI

TMAE TMCR

oo a0
LCD4 LCDa&
SE

[ Display PAGE 2 Register}”’”"
J

| Display PAGE 3 Registerj//

Register byte \ﬁ"’”——

N B P [
Register bit
g MCECHZ

>

Ssr WYl TELI'TE.| TELD | PROD | TMER | CCPOR
o054 ooss 0000 0000 032E TFIE nols FFO0 FFFF
ccPlE e
FFFF
—»PAGE] AGE2 __yPAGE}
STEPTE|}| STEFL . STEUH  STEOV - STEPRISSTEPRTZSTEPRT]STEPRIO |
INTEL [} GIE =~ ADCIE TMCIE TMEIE TMAIE WDTIE ELIE EDIE
- INTEZ - - - - - SSPIE  CCPLIE CCPOIE
INTF1 - ADCIF TMCIF TMEIF TMAIF ‘WDTIF  ELIF EOIF
INTF2 - - - - - SSPIF  CCPLIF  CCPOIF
STATUS - - - C D H av z
PLIATS || TO IDL EOR . SEERR . .
LVDCH m-/mﬁmop LYDON VLDX3 VLDXZ YLDEl VLDED
[ENVDD4 YDLDAZ] VDDAXOD ENMACH - - - -
ADCS2  ADCS]  ADCSD ADCCKE  XTHSP  ZTSF  ENXT ENRCIM
- - LSCK  HSCK  Hssl HSs0 CPUCKL CPUCKD
MCECH3||LCDs2  LcDsl  LCDSO - PERCKE  BZsl BZ51 BZ50
Figure 3-7

Revise Indirect Addressing Data or Address

After setup as Figure 3-8 illustrated, Address can be revised through typing on the keyboard or by

pressing the value by mouse.

e

Revise indirect
address

AN

FSRO=05A
|
| - -
11P133pecial Regmster
% 0] 1]2]3]
D0: M[054 =10 | [Prog - s 6[ =
Modifyr Wal WEE
| Moty Vel gloaln
c|p|E|F
lemory checked OF
¢ click the left key \‘ — ]
\ of the mouse J Clear I Cancel

Figure 3-8

After setup as Figure 3-9 illustrated, Data can be revised through typing on the keyboard or by pressing the

© 2008-2010 HYCON Technology Corp
www.hycontek.com

APD-HYIDEO01-V03_HYIDE SUM_EN —page 25



HY-IDE Software User’s Manual

HYGON

HYCON TECHNOLOGY

value by mouse.

FSRO=05A4 [X)

"
LReviseindirectdata J—#HDD:M[DSA]ﬂD | | Progr - il L
| Modify Valoe WEE 3 Lo P
Madify FER( §|9|Aa|B
C|D|E|F
[ Click the Teft key ] lemory checked OF
of the mouse e
Clear | Cancel

Figure 3-9
> Revise WREG Data

FSRO-05A (8

evise
[—REZYI;EG—\’—WREG P (o3 T —

TS

3y

3
7
B

Cp B - T
B | |w | =

Lz I - - O S

F

( Click the left key W Temory checked OF

of the mouse
Clear | Cancel

Figure 3-10
»  Revise single 1 byte or Word Register Data

Byte
INDFO  POINCO PODECO  PRINCO PLUSWO INDFL  POINCL PODECI PR_INCI)

PLUSW1 ADCFH  ADCEM  ADCEL | TMAR

= AS 0l Juli] Juls] Juls] o}

T4

Mouse click

LCD7 LCD=E

L LCDE

1] 2
FSED | FSR1 5|6
0054 | 0083 032E | 7FIE | 0018 | FFOO
9 |A|B )
D|E|F r
Ternory checked OF
Clear | Cancel
Figure 3-11

»  Revise Register single 1 byte or single 1 bit
After Bit is configured as 1, its value will be highlighted in blue font.

After Bit is configured as 0, its value will be shown in black font.

Revise through
keyboard key in
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PAGE] PAGE2 PAGE3
——===
STEPTR | STEFL STEUN STEOV _ STEPRT3STEPRTZSTEPRTI STEPRTO
Double-click the mouse INTEL | GIE  ADCIE TMCIE TMEBIE TMA4IE WDTIE ELIE  EOIE
left key INTEZ . . . - . SSPIE  CCPLIE CCPOIE
INTF1 . ADCIF TMCIF TMEIF TMAIF WDTIF ELIF  EOIF
INTFZ . . . . . SSPIF  CCPIIF  CCPOIF
STATUS = = = C DC il oF z Double-click the mouse
¥ TO IDL EOR - SKERE - - left key
(Value inputdialogue pops Up) ’ LY¥DFS: L¥VDOP LYDON VLDES VLDES O VLDX1 VLDED
|[ENVDDA YDDAX] YDDAXO0 EMACM - -1
IR W aDcsl  ADCSD ADCCE  XTHSP a7
. LSCK  HSCK  HSSL | wwww  PUCKD : i
LCDSl  LcDso - PERCE  BZS1  BZS1 Bit setup dialogue pops up )
0|1]2]3]
4| 5|67
«Q
2|9|A|B
C|D|E|F
Temary checked O
Clear | Cancs]

Figure 3-12

3.4 Watch Window

Data Type

0 |on iy

10110110

Watch Name | | Watch Data Data Length

Figure 3-13

»  Watch Name - Monitored Data name, program uses EQU or DS defined name.
»  Watch Address - Monitored Data Address
»  Watch Data > Reveal data. It is selectable to be arranged from right to left or from left to

right. It can also display decimal or hexadecimal system.

ADC OFF Hex (H--=L) LCD2 | LC

e ADC outp bits e | OptlonS appear
&Y Hy_WATCH . after clicking

——( Point the mouse
cursor here, and
double click it

Figure 3-14

Hex (H - L): Hexadecimal display, address H/L shows from low to high
Hex (L = H): Hexadecimal display, address L/H shows from high to low
Dec (H - L): Decimal display, address H/L shows from low to high
Dec (L = H): Decimal display, address L/H shows from high to low

——————— ———————————————————————————————————————————— ]
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»  Watch Data for Bin = Data display in binary system, only for those EQU defined Address.
»  Data Length = Data length, showing DS definition length; if EQU definition is applied, this

value will show “2”.

»  Data Type > Data type; D = DS definition; C = EQU definition.

Add/Delete Watches
Edit Watch
Delete Watch AlDr

Delete A1 Watches
Hide Addr

Load Froperties
Save Properties As
Clear All Properties

Monitor EQU defined Register or RAM, click the right key of mouse to select add-in monitored

Register or RAM as Figure 3-15 described.

Watch List Other Constant
AddDelete Watrhes > Rl > I %gi¥ﬁ z
Edit Watch REGDATA?
Delete Watch AlD << | RSIM
RSLEN
Delete 41 Watches RSQRT
2 |l
Hide Addr ‘ EXaD
Lioad Properties —, E _REG 7
Save Properties As cTTt T
Clear 411 Properties Del Add

Figure 3-15

3.5 Stack Window

b zmmbledfRun S Stack rs_<|
| Edit Alts] :
(I — A2 Stack= ) '
| Hex A3 1
| Wath Altrd 2
{ Static RAM A5 —_— |
| pecisl Regiter  Alt+6 4
5
6
ADC Panel Alt40
(P Panel
Next File AltsRight
Frevious File A1+ Left
Figure 3-16
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 Display stacklayers |
( N
' Display stack address | —— PR—
2
3
4
5
6
Figure 3-17

3.6 ADC Window

ADCCK,
INH[Z:0] =[{iEE -] Ls CK l EMADC

[
(R -+—+ ADCS[20)=

ition Chip =HY - 11F13

[ l WDhDA |00 ~| VDDA = External

L ais >4 [ooo -] | 1
Assemble&Rum [ a4 S+ ! oo <] Joo =] | -osReo- [000 -]
Edit Alt+l C &0 >J|-/'J|~ | DCSETIZ:0l ADGN[za] | ADC Output Rate
Source AI42 LoD/t [oo o] | Hell VREGN || o ADC_CK / 256
[ A0 S-—ek T I 5D Chopper on EMCHF : 1bit % 24 bit
Hex Alts3 CTPsH> -4 (=1 oPAMP-L ENHIGN & ADCROH/ML ADCIF
Watch Altd [iTPotC-— ADEN =174 £} ADC OFF

Static RAM AIH5 —

Special Register  AlMA
Stack A7

ZAAD
YREGM=x 1

ADC out mode  ADC outp bits

HEX - 15 -

Read ADC

AlHd

. . ;
I'IextlFﬂa . Alt+Right L__T_ i
Previons File Alt+Left l%F [ &3 >+,/+
ir ........ ; .E_n [ ﬂ|2 >+’/-r'
4B e e
o _ _
o 1\-121—1[1 0= E/HI_[I'Dl =
o _- 0 -
Figure 3-18
© 2008-2010 HYCON Technology Corp APD-HYIDE001-V03_HYIDE SUM_EN —page 29

www.hycontek.com



HY-IDE Software User’s Manual

HYGON

HYCON TECHNOLOGY

| ADC Sample Clock || ADCCK | | ENADC | | VDDA |
7
oY AD m | DC Offset
ADCCK
INHz0] =[aTT -] l ENAD |1 ADGN
L ]
e e UF bppe | VvRoN
INH C s >l |[000 <] (4=——= — . '
[ a4 i 1 [101 =] [110 -] ] OsR[a) = P~ ENCHR
EMII}{-——} : DCSETIZ0—h f—ADGNZ0L L | utput Rate
LoD > | S-VRE-1/4 [TFCH ADC_CK 7 | ENHIGN
CREFD ey I 5D16 Chopper on EMCI == w
Crpsto— 1 | OPAMPL JI{ ENHIGRY 0 S EDCROATAL ADCTF
INX ErTPsH—= i ADGN-x16| | | % ADC OFF OSR
: DD : ADC out mode  ADC outp b
- iij VRGN=x1/2| | e -] [16 < -
INIS ] I Display ADC Value |
L a3 AN i | : Read 400
% || PeacnrolH @ I = Display ADC
_— N i e i
INBUFF | AT ! output bit
COPO0 """ | YERBUFF |
s I o _\ll Selection ADC
G+ TPSL - - output value type
C-TRSL ="+ R ==
INL L—_T—' [ANDMH"wtq [ &1 5ot
UII;I]I_|2:0]= [ 48 >+/+ A9 +,/+ ADC output
| button
[HEFD>—:/_=1- Y55 >+:/-4I-
1\-121[ 0] = EIF{I_[I'DF
[1p -] 10 -
PGA | | VRH | | WRL | | VERBUFF
Figure 3-19
> INH Network
(1) Click the network by mouse, INH can select the specified network.
(2) Click the network switch by mouse, INH can select the specified network.
(3) Click the mouse, a menu as Figure 3-20 will appear and users can select the switch network.
INH[Z:0] =[117 -
Figure 3-20
> INL Network
(1) Click the network by mouse, INL can select the specified network.
(2) Click the network switch by mouse, INL can select the specified network.
(3) Click the mouse, a menu as Figure 3-21 will appear and users can select the switch network.

INHZ0] =[111 ~

Figure 3-21

e R e e S e
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> INIS Switch
(1) Click the specified network by mouse, INIS switch will turn ON/OFF.
(2) Click the specified network switch by mouse, INIS switch will turn ON/OFF.
» INX Network Switch

(1) Click the specified network by mouse, 4 switches are shown as Figure 3-22.
r@*@*@*@

Figure 3-22

(2) Click the mouse, a menu as Figure 3-23 will appear and users can select the switch network.

Figure 3-23
> INBUFF Switch
> Click the specified network by mouse, INBUF switch will turn ON/OFF.
> Click the specified network switch by mouse, INBUF switch will turn ON/OFF.INL network.

(1) Click the network by mouse, INL can select the specified network.
(2) Click the network switch by mouse, INL can select the specified network.

(3) Click the mouse, a menu as Figure 3-24 will appear, and users can select the specified switch

network.
Figure 3-24
> ADC Sample Clock
Click the mouse, a menu as Figure 3-25 will show up, users can select the specified switch
network.
ADCS[20]=-

ooo -

Figure 3-25
» ADCCK Selection
(1) Click the specified network by mouse, ADCCK will switch selection.
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(2) Click the specified switch by mouse, ADCCK switch will switch selection.
> ENADC
Click the specified network by mouse, ENADC will turn ON/OFF. When ENADC = ON, display ADC
zone will output value.
> VDDA Net work
ENVDDA enable control
(1) Select ENVDDA switch ON/OFF.
(2) Select VDDA voltage.

Click the mouse, a menu as Figure 3-26 will show up. Users can select to specified mode.

V[]_DA o -] 1

|

i
|
'U] I
Figure 3-26
(3) Display VDDA Voltage
When ENVDDA = 0, the zone will show VDDA = External
When ENVDDA = 1, the zone will show VDDX selected voltage.
> PGA Network

Click the mouse, a menu as Figure 3-27 will appear. Users can choose the specified network.

|
PGAGN[1:0] =

Figure 3-27
> VRH Network
(1) Click the network by mouse, VRH can select the specified network.
(2) Click the network switch by mouse, VRH can select the specified network switch. VRH can
choose the specified network.
(3) Click the network by mouse, a menu as Figure 3-28 will appear. Users can select the

specified switch network.

L\.-’RH[1:CI] =

Figure 3-28
> VRL Network
(1) Click the network by mouse, VRL can select the specified network.
(2) Click the network switch by mouse, VRL can select the specified network.
(3) Click the mouse, a menu asFigure 3-29 will appear. Users can select the specified switch

network.
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Figure 3-29
> VERBUFF
(1) Click the network by mouse, VERBUFF switch will turn ON/OFF.
(2) Click the network switch by mouse, VERBUFF switch will turn ON/OFF.
> DC Offset Network

Click the mouse, a menu as Figure 3-30 will show up. Users can select the specified network.

Figure 3-30
> ADGN Network

Click the mouse, a menu asFigure 3-31 will appear. Users can select the specified network.

Figure 3-31
> VRGN

Click the network by mouse, VRGN can select the specified network.
> ENCHR

Click the network by mouse, ENCHR can select the specified network.

Notice: ENCHR lightening up means ADC Chopper is closed.

> ENHIGN
> Click the network by mouse, ENHIGN can select the specified network.
> OSR Network

Click the mouse, a menu as Figure 3-32 will show up. Users can select the specified network.

OSR[2:0] =

oo -

A quug

Figure 3-32
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(1) Select ADC value output type = Hex or Dec output is selectable.

(2) Select ADC value output Bit = selectable 8 ~ 24 Bit output.

(3) Display output button - Click this button can immediately display ADC value.

3.7 OP Window

Edit

Source

Hex

Watch

Btatic RAM
Special Register
Stack

ADC Panel
OF Panel

Hext File
Previons File

OPOP

[_oros ]

OPOIS

Chip = HY - 11P13 {
AzmmbledFun

Alt1
AlH2
Alt3
A4
AlH5
AlHA
AlW7T

L1489

AlHRight
AlHLeft

A1 +4]5

AI0+AI5—

OFP[1:0]

EMHOP OPw[1:0]
Chopper ADC_CK /64
:__' WODA _I!:H:I_;l ¥DDA = External
| [
: : OFo
[
| : OFF
= )
ADC_CE

Alx

oo -

OPN[2:0]

Figure 3-33

|

— OPOM[1:0]
Chopper H

Dan_x

Al N?

| n——1
N

Lty

4 [oon -]

HS_DCK

DAn.x
Alx E—&Alx ﬂ
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> OPOP Network
(1) Click the network by mouse, OPOP can select the specified network.
(2) Click the network switch by mouse, OPOP can select the specified network.
(3) Click the mouse, a menu asFigure 3-35 will appear. Users can select the specified switch

network.

Figure 3-35

> OPON Network
(1) Click the network by mouse, OPON can select the specified network.
(2) Click the network switch by mouse, OPON can select the specified network.
(3) Click the mouse, a menu as Figure 3-36 will appear. Users can select the specified switch

network.

Figure 3-36

» ENOP
Click the network by mouse, ENOP will turn ON/OFF.
ENOP status display
When ENOP = 1, it will display ON
When ENOP = 0, it will display OFF
» VDDA Network (Please refer to VDDA network of ADC window)
»  OPOM Network
Click the mouse, a menu as Figure 3-37 will show up. Users can select the specified switch

network.

Figure 3-37
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3.8 Comparator Window

S Comparator
CEIH1:0] cPic | VDDA = External
. e - | J. 00 -] cPox CPOFR | PwMTROl PM2E0
i VDD l TC27 | TC2E
Chip = HY - 11P14 ] i I_,H_‘_N'\ Daz7 | DAZE
BRI ] [ 7 Encea CPAO
N A zmembledRun [CapiD_—— s
- Al I _r CP2 OFF
it t (o
: Al E— N CP1OFF
Hl:uu.rce N +3 st \[ CAPAT _I_
54 [t r—-7 51
: r . = YDDA
Watch Altrd L] [ e LA
Stati RAM Al5 — o = LI
Special Register  Al4A _L | e VP = 1000ri
| VR13 = 937 5y
Back Alt+7 : = £ YR12 = 876m
il YRT1 = 512,65
ADC Panel Alt+9 ot Y¥R10 = 750
(s ! I VRS = BE7.5mY
___1 VR = B2y
L cPLED) VR = 562 By
. . - WRE = 437 B
Mext File Alt+Right [T FR
Previons File A+ Left YR = 312.5m
V3 = 250y
: VA2 =187.5m
VR = 128y
T .
L : | & vRo-s2smv
- L ——
CPVRS[310]
Figure 3-38
| ENcPA || cPpx | | wvbbAa | | cPox | | cPoFrR |
- i - | m_-|| cro¥ CFOFR_ | fwMTRO| Phz.60Y PT2.7
r DD l TC27 | Tc2s
[ Cepiz > ; _ Ds27 | DA2E CAPAT
CPIH e | [ Ak ' “p——fFero | | Enable
4 — |
I c ? OFF
=
—— Remcs olze YOO CPIOFF | Tcpves
[osr | || o ew® T
CAPIT =" L ===
el e i al
1 ! | AC ACM
1 1
— | : | 026 :vPD
E—:—”" b ——— Tempergture WP = 1000
WR13 = 937 Bmiv
WR12 = 875y
WR11 = 812 5my
CPIL YR10 = 750y
YR = BE7 By
R4 = B25mv
cs1 WR7 = 552 Sy
T — -
T I YRE = 437 Bt
Y -]
| oo | e ——— | YRAE = 375m\ CPVRS
11— - R4 = 3125mV
cs2 |- 1 [ f YRS = 250
1 —
: : WR2 = 187 Bm
I WA =125my
T
- : : VAD = B2 5y
- L — —
CPVRS[E0 — 1
Figure 3-39
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» CPIH Network
(1) Click the network by mouse, CPIH can select to the specified network.
(2) Click the network switch by mouse, CPIH can select to the specified network.
(3) Click the mouse, a menu as Figure 3-40 will show up. Users can select the specified switch

network.

CFIH[1:0)

Figure 3-40
» CPIL Network
(1) Click the network by mouse, CPIL is select to the specified network.
(2) Click the network switch by mouse, CPIL is select to the specified network.
(3) Click the mouse, a menu as Figure 3-41 will appear. Users can select to the specified switch

network.

L_cpizo)

ml -

Qoo

Figure 3-41
» CPVCS Network
(1) Click the network by mouse, CPVCS can select to the specified network.
(2) Click the network switch by mouse, CPVCS can select the specified network.
(3) Click the mouse, a menu as Figure 3-42 will show up. Users can select the specified switch

network.

Figure 3-42
» CPVRS Network
(1) Click the network by mouse, CPVRS can select to the specified network.
(2) Click the network switch by mouse, CPVRS can select the specified network.

(3) Click the mouse, a menu as Figure 3-43 will show up. Users can select the switch network.

Figure 3-43

——————— ——————————————————————————————————————————————— ]
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» VDDA Network (Please refer to the VDDA network of ADC window)
» CPIX Switch
Click the network by mouse, CPIX will switch.
» CIST
Click the network by mouse, CIST will turn ON/OFF.
CIST status display:
When CIST =1, display ON
When CIST = 0, display OFF
» CS1 Switch
Click the network by mouse, CS1 will switch up and down.
» CS2 Switch
Click the network by mouse, CS2 will switch up and down.
» ENCPA
Click the network by mouse, ECPA will be activated.
ENCPA status display:
When ENCPA = 1, comparator is enabled.
When ENCPA = 0, comparator is disabled.
» CPOX
Click the network by mouse, CPOX will turn ON/OFF.
» CPOFR
Click the network by mouse, CPOFR will switch up and down.
» CAPAT enable
Click the network by mouse, CAPAT module will be activated or inactivated.
CAPAT status display:
When CAPAT = 1, CAPAT module is activated.
When CAPAT= 0, CAPAT is inactivated.
» REFO Switch
Click the network by mouse, REFO will turn ON/OFF.
REFO status display:
When REFO = 1, REFO is activated.
When REFO = 0, REFO is inactivated.
> PT27
CAPO will output only when PT2M.7 =1, TC2.7 =1 and DA2.7 = 1,.

3.9 Register & SRAM Revise Record

If the register or SRAM has been revised manually after access to emulation window (hardware
emulation or software emulation), the data will be recorded (despite the RAM, Register, ADC, OP and
CMP is revised through any kind of window). The data will be revealed after pressing the button “RAM

revise record”. At this time, windows will suspend until it is closed to execute other commands.
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File Edit

= 10
= nii

H¥»IDE - Emulation

&y

Chip = HY - 11F13 {4K)
Zearch Wiew ALzmmblefEun

F:'.\t Cnn!:inue Cc@pﬂer

™oTe (Y

Cption:  Windows BEEERLEEEEG

HYCON TECHNOLOGY

ICE Inteface = USB Froject =

\ltem N\ Mame\{

Address | LastData | Befor Data

Display continued
or discontinued
status

N\
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Display \ _
SRAM&Register reco Create New File

Add Current PC Address

Save Fecord Continme

Download v Mot Continne

Clear Fecord

Clos

Display save or clear
status
Status: Not Continue
Figure 3-44
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L ROIEE SOl _E@

CcREle d@ o &

KitchForl IP13 as | INTERRUFT ASM | SPLASM | INTADC ASM | SYSINLASM | KEYSCAN ASM | MAINFR 4| »

(PC Stop Address)

(Add New Program)— |
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- ; Ecs pIn BHi1EE0 2 BHOEEL @riERE SEICNT -]
_ org 0000 AR ST e e i Dt o - _J
] E
1 Fil: Contime
o flom [ | Croate New Fil B
= BT o004 2 Alnemem DS e 0Dh
= Include
= FroBegin:
= include
mwl u]
mvl
mvf
mvl
mvf
-  MainLoop: [Status: Not Continue

\c:/ “CAProgram Filess HYIDE\HYIDE\DemoCodeKitchenScale\KitchForl 1P13 asm” had been : modified, Rebuild Madn Program?
-

Il0|

mclude  Swslntasm
mvl CEQR
mvf  SPIINDEXL,F.ALCE
L MYVL  05Ch
MYWE 0040k, 1,0 ;MVF AINET2, F, ACCE
MYVL  00Ch
MYWE  003Dh, 1,0 ;MVFE ADCOCNZ, F, ACCE
; oL B DE FEaR
mvl  13h EEREIES
mvf  OF5h,F,ACCE
il A v
< >
Figure 3-45
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3.10 Hint Function of Source Code Window

If users intend to know Register or SRAM value and Address in source code window, point the

cursor to register or SRAM, the name, address and data can be revealed.
This function is only applicable to the instructions below:
CLRF, ADDF, INF, INSZ, DCF, DCSZ, SUBF, COMF, ADDC, ANDF, IORF, XORF, SUBC, RRF,
SETF, MULF, RLF, JZ, RRFC, RLFC, SWPF, DAW, INSUZ, DCSUZ, ARLC, ARRC, CPSG, CPSL,
CPSE, TFSZ, BTFG BSF, BCF, BTSS, BTSZ, MVFF(not Macro).

» Only the first followed argument is effective as Figure 3-46 described.

» When command is BCF, BSF, BTSS, BTSZ and BTGF, Byte value will be revealed if the cursor
points to the first argument. If the cursor points to the second argument, it will display the specified
Bit value (1 or 0) as Figure 3-47 illustrated.

» When command is MVFF (not Macro), first argument value will appear if the cursor points to the
first argument. If the cursor points to the second argument, argument value will show up as shown
in Figure 3-48.

» If the argument is INDFO, POINCO, PODECO, PRINCO, INDF1, POINC1, PODEC1and PRINC1,
the Data will be FSRO or the address Data of FSR1 as

> Figure 3-49 described.

» If the argument is PLUSWO or PLUSW1, the Data is FSRO+WREG or the address Data of
FSR1+WREG as illustrated in Figure 3-50.

'Name| | Address || Data |
= I1nsSl1lde ﬁ?SLru“ as

mwl OEOh

v £ SPIINDBEL, F, AC
el 13h ; BRERIAS
v f 0F5h, F, ACCE
rvl 1h = i

Figure 3-46

Show Byte Value Show Bit Value
r AlLW LoL M"IJ.'H 'J.;MU\-J.'H '
- j=============
- . -
, .
. - MainLoop:
- MainLoop:
btsz SVECHN,WVEOP ., ACCE

btsz bt
RLCDE

bt s :

htss=s SVICH, 3V30R, ACCE
ht=s SVICHN, 3V30P, ACCE

hef RLCDG, b_lbat, ACCE

Figure 3-47
————————————————————————————————————————————————————————————————————————————————————————————————————————————————————
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First argument | | Second argument |

bsf INDFO, 4, ACC
bsf INDFO, 4, ACCE
= ; A3 10,80h
= ; &% 10,80h
mvEf RAMFo+1, ADCFg+1
mwvit RAMFg+1, ADCFog+1
- P e e __
= MainLoop: - iy
- MainLoop:
btsz BWECN, 3VECOR, ACCE L e e
Figure 3-48
Name FSRO | Data

address

INDF\, PLUSW

mwvit
bsf INDYO, 4,A4CE L
mvtf PAMFg+1, ADCFg+1

H
MainLoop:
bts=

1- — &

AVACH, 3VE0P, ACCE

T ST 1-

Figure 3-49

T - - LT

FSRO+WREG
Address

Data

mwvl

mvit INDF1, PINI2W0

bsf TNDFO, ELUSHD [145h] = ATh
; A3 10,80h

mvEf PAMFg+1, ADCFg+1
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4. Programming Window

4.1 Interface setting

Click “Option” button and select interface setting to get access to programming window as

S HyIDE1OD - Mode:[Edit] v1.08

Chip =HY - 11F12 (4K}

ICE Inteface = UEE Froject

File Edit Search View AzembledFEun Options  Windows

Interface Setup |

Figure 4-1 described.

© 2008-2010 HYCON Technology Corp
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s Interface Setap

Interface Setup Build Options

Int Setup ICE Test

Register

Chip Select

P13 [4K)

Select Chip |

Languags

Englsh -L

Hasdware Interface
* Interface Mode

\
\
' Select Language |

. USB Interface |

USB -t

IDE Mode
" emulate and Debug

@ Programmer <

Program Mermory Select

i -

Close |

Select
Programmer
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S HyIDE1OD - Mode:[Edit] »1.08 Chip =HY - 11F12 (4K} ICE Inteface = USE Froject

phion:  Windows

File Edit Search WView AszsembledEun

ﬂ Interface Setup

Interface Setup llnterfnce Setup Build Options
Int Setup ICE Test
Register

Chip Select P13 (4K e . Select Chip
Language  |Engish g ' Select Language |

Hatdwate Interfacs
* Interface Mode

USB E . USB Interface |
IDE Mode
" emulate and Debug
& Progiammer < Select
e e e Programmer
[ =

Close |
Figure 4-1

IC Selection - Select the IC part no. If the programming IC differs from the selected part no.,
Blank Check, Program and Verify will fail.

Language > Select the language of operating interface, either Chinese or English.

Hardware Setting - USB or Parallel Port interface is selectable.

IDE Mode - Select programming.

When the interface setting is accomplished, click”’Assemble Option” to select programming setting
as Figure 4-2 indicated.

EEX
Interface Setup . Build Options - »  Build Option
Int Setup | ICE Test
Register No Use Area Fill
Generate Files ¥ Enable Tool Bar 0x0000
W Hexfie Fort / Or
'; ol No Use Area Fil OxFFFF
Generate Files y [ & 0
I ASClI fie CoORF / Smart Compiler |
v Smaull.‘.ornpiler‘/
" PogemPggel L Program Protect |
Stack Option Compiler Select
—
Stack Over Reset T Stack Over resel g
=
Input Program Times InPUt_ Program
Enable Program | Jgb EnebleProgamTimes [ <& times
Times

© 2008-2010 HYCON Technology Corp APD-HYIDEO01-V03_HYIDE SUM_EN —page 44

www.hycontek.com



HYGON

HY-IDE Software User’'s Manual HYCON TECHNOLOGY

Figure 4-2
Assemble Generated Extension = The generated file after selecting the programming program.

Stack Operation - Select whether to replace when stack overflow/underflow

occurred after OTP program operation.

Fill Unused Zone -> Fill the unused zone with 00 or FF in the program after
programmed.
Simplified Assemble - Select whether to simplify assemble.

Enable Programming Times - Select whether to enable Download program’s programming
times.
Input Programming Times -> Fill in Download program’s programming times. (Maximum is
2147483646, minimum is 1).
After assembling finished, click “ICE Test” to evaluate testing voltage as Figure 4-3 described

(Connect IDE and insert 9V power before clicking”Option”).

S Interface Setup E]@l@

Interface Setup Build Options
Int Setup ICE Test
R Show VPP
SRAM Data Voltage
Address VPP / 9
Wite Data l— 621 (
Read Data
CK VPP Check VPP
Write: I Read [ J
Program ROM Data 3\0(:(;, Show VCC
Address [— e Voltage
‘Wiite Data CKVIC TN
Read Data \
Wit Read Check VCC
\ Check VPP and
VCC
Close |

Figure 4-3

Click “Close” after the interface setting is done. All arguments will be recorded. When the setting
is opened next time, default value will be written in automatically and the selected programming IC

part no. will be shown in topic window as Figure 4-4 described.

S HyIDE100 - Mode:[Edit] v1.03 Chip =HY - 11F13 (4K} ICE Infeface = OSB FPioject =

File Edit Fearch View Programmey Cphons:  Windows

® = @ | om0y oGy @

Conform OTP
Chip

Figure 4-4
VPP voltage while programming: 5.6<VPP<6.6.
VDD voltage while programming: 2.7<VPP<3.6.
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4.2 Operation Procedures

XY H¥IDELOD - Mode:[Edit] v1.08 Chip = HY - 11P13 (4K) ICE Inteface = USB Project =

Open Compiler g1t Edit Search  Wiew Programmer Options  Windows
Main File
N Doy G O §

Cpenid) Ctel+Or

Down Load Hex Open Project

File To Bave Project
Programmer’ s
Flash Memo DownLoad To Flash Memory
ry /\ead Frova Flash Memorny

Exit(D) CtltQ

Read Programmer’ s
Flash Memory
(Only For Writer Version)

Figure 4-5
Open > Open the programmed source code main file.
Open Project > Open the saved project.
Save Project > Save the finished project.
Download file to Flash Memory - Download the finished Hex file after assembly to
programmer or IDE Flash Memory.
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4.2.1 Open File and Assemble

SH}[DE[BU - Mode:[Edit] v1.08 Chip = HY - 11P13 (4K) ICE Inteface = OSB Project =
File Edit Seamch View Programmer Options Windows (101

n o Oy Oy b: o §

HYGON

HYCON TECHNOLOGY

Mo [P

3

=
v

3

SPICNT : FU ISP E

SPICNT =0 => SPIBUF#IRit7 = | 5& , SPIBUFMIBt 7=0 8
SPICNT = | == SPIRUF = }§FERAM Address 89 Low byte --> FSROL
SPICNT =2 == SPIBUF = {&§FRAM Address 89 High byte --> FSROH
SPICNT » 2 => ¥ FEERAM Address SETEREENE

; SPICNT ol #8838 255
s ECS PIN 691950 55 sHOd% | S980 SPICNT

org 0000h

jmp ProBegin
nop

jmp 0
org 0004k

Include Interruptasm

¥
ProBegin:

meclode Syslntasm

mvl OEOh
mvi SPIINDEXL,F,ACCE
| AR
mvl 13k ; B ES
) ) mvf  OF5h,F,ACCE
Display Main ol 1h . Ein
Program File Wl e e e v
q < #
RN I Modified

E: WCYPRESSVIDELCH\ Application OnlyADC Testld\OnlyADCLld hex

| N r.cc:sun = 0:x2346

Figure 4-6

Open source code main file and display the assembly file. If the displayed name differs from main file,

point the cursor to the file and press mouse right key. Set this file as the assembling main file as shown in

Figure 4-7.
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Mainine KitchForl IP13.asm ]

L

b
: SPICNT : RSP =
: SPICNT =0 = SPIBUFRIBLt7 =158, SPIBUFRYBLt 7=0 5

: SPICNT = 1 == SPIBUF = }8FRAM Address B Low byte --> FSROL
: SPICNT =2 == SPIBUF = }85FRAM Address 87 High byte --> FSROH
: SPICNT » 2 == ¥f J8FRAM Address FETEEENME
: SPICNT-7~ Af#B:% 255
: ECS PIN B850 2 o8 1 &i&ks SPICNT
org 0000h
imp  ProBegin
nop
imp 0O
org 0004k

Include Interropt.asm

FroBagin:

Click Mouse Right Key.
Set Program Main File

include  Syslniasm file: KitehForl 1P13 ssm
; file: Main ing

mvl  OEOh Sot Bookmsrk 8

mvf  SPIINDEXL,F,ACCE amu Bookmazk ,

; SRR E R =

myl 134 : el b Cloze file Cirl+F4

mvf  OF5h,F,ACCE T

mil Ih AR v
Fy >
1:1 Modified

Figure 4-7

Assemble Source Code and Download it to programmer or IDE Flash Memory as Figure 4-8 described.

%3 HyIDEL0D - Mode:[Edit] v1.08
File Edit Seaxch View

Chip = HY - 11P13 (4K}

Programmer Options  Windows

10
i

53

ICE Inteface = UEB FProject =

Assemble and Download
to IDE Flash Memory

Successful downloaded to
programmer or IDE Flash Memory

C:A\Program Files\HyIDEAHvIDE\DemoCode\KitchenScale\Ki

Represent enable program

Program Times Download OK !l
Program Times Function Enable ***** Program Times = 100

times

Display this program’s
programmable times

Figure 4-9
1. When using USB interface, the finished program code will be loaded into programmer or Flash
Memory of IDE for mass production programming.
2. If there is programming times in the assemble option, information column will display the times of

programming times as shown in Figure 4-9.
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3. After assemble completed, Hex filename and Checksum will display in underneath part, as Figure
4-10 illustrated.

Download To . .
, Display OTP Display Program
Programmer’ s -
Connection Status Checksum

Flash Memory

E:ZCYPRESSYIDELCMY TestDeno', TestDencoboard. hex Body & board |Checksum = 0xDOCO
Figure 4-10
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4.2.2 Download Hex File to Programmer or IDE Flash Memory
To program an assembled Hex file, click “File”, select “Download to Flash Memory”. Choose the

specific Hex file to conduct programming. The option of last step varies by compiling option. If the file is
protected, program will not ask whether to protect the file. If not, a window will pop up and ask whether

users would like to protect or not, as described in

OpeniQ) Ctlr
Cipen Project
Save Project Down'Load Hex
File To
DownLoad To Flash temony Programmer’ s
efnony Flash Memory

Lok in: |l'f) KitchenScale j ¥ Ef-
\ =] apc [Z] sysIni
35' [Z] apccal

fy Recent [Z] Display
Documents [Z] Hosa

T [Z] rtanc
m Interrupt
Desktop m Keyscan
__) [Z] LaoInDy
2] Mai
My Documents % M:::Pro
. [Z] Math
:,I)_g [£]) s24cnx
[£] sp1

iy Computer
r.;] Subroutine

My Network  File name: IKitchForl 113 | Open
Places
Files of type: I |".He:< ﬂ Cancel

i

v

: Souxce Code hadn't been protected, Protect?
L3

'

Figure 4-11.
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Cipenin

Cipen Project
Save Froject

Dowenloosd To Flash WMemorny
Eead From Flazh Mep

Chl+O

HYGON

HYCON TECHNOLOGY

Down Load Hex
File To
Programmer’s
Flash Memory

Lok, jr: | [ KitcherScale j ¥ EB-
\ Z] apc [Z] sysIni
@ [£) apccaL
Iy Recert [Z] Display
Documents ] Hoga
?[* ] miapc
@ Inkterrupk
Desktop [Z] Keyscan
_ B
__} % LCDIND
=| Main
My Documents Ec] MainPra
[Z] math
'31)3 [£] sz4cmm
tdy Computer E] SPI
E] Subroutine
by Hetwork File narme: |KitchF0r1 113 j Open |
Places
Files of type: I *Hex ﬂ Cancel

AN

Source Code hadn't been protected, Frotect?

Figure 4-11

Information column will show success message after programming succeed, as shown inFigure

4-9. The Downloaded Hex file and Checksum will also be revealed in the indication column asFigure

4-10 illustrated.
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4.3 PC Online OTP Programming

S HyIDE10D - Mode:[Edit] ¥1.08 Chip =HY - 11714 (8K} ICE Infeface = UEB FPioject =

File Edit Hearch Wiew Programmer Ophong  Windows
[P i i e Oy O o8 - 2]
| A
Display Hex Code g:;::l:( Program Verify Read Auto
Figure 0-12

Figure 4-13
Blank Check, Programming, Verify and Read command can be implemented when the

programmed file being successfully loaded into programmer or IDE Flash Memory. On the contrary

those commands will not be activated if the download is malfunctioned.

OTP Chip does not
match with the

Chip ID Error!! Program Chip ID = 0x0043 =

selected IC
Figure 4-14
OTP on
Line
E:WCYPRESS, IDELCMY TestDenc TestDenohoard. asn Body #n board  Checksum = 0xDOCO

Figure 4-15

OTP has not

been found

’:u:\cwmsunn-nnx\m-mmxnsr\11p13-123:;5:\1(1::1;?“111:13.hax RSN Ch:cksun = Ox45AC

Figure 4-16

Make sure the selected programming IC part no. is the same with the OTP part no. in topic
window as Figure 4-4 described. When programmer executes Blank Check, Programming and Verify
commands, Program will check whether the IC part no. and OTP programming part no. are identical. If

the part no is different, the data will not be written into OTP and an error message will display in
information column

as
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OTP Chip does not
Chip ID Error!! Program Chip ID = 0x0043 - match with the
selected IC

Figure 4-14 described.

If users intend to find out whether the part no. is correct before programming, point the cursor
to "IC Connection Status Display” and click the mouse left key. If the IC part no. is correct, a message
will show up as Figure 4-15. If it is incorrect, the message will display as Figure 4-16. If “Enable

Program Times” is ticked, the spare program times will display in the message column as illustrated
Figure 4-17.

S Mezsage
Program Times Left 998

Figure 4-17

4.3.1 Blank Check

The internal code of Blank ICs that have not yet been programmed is OXFFFF. The purpose of
checking the IC is to assure the OTP address content is OXFFFF.

If the IC selection is correct and the content is empty, a message will appear as Figure 4-18.

SBM Blank OK

Figure 4-18

If the IC selection is incorrect or the content is not empty, a message will show up as Figure 4-19

described.

Figure 4-19

O
4.3.2 Program ™
The purpose of programming is to write Compiler accomplished program into IC OTP. When

programming is completed and the IC is assembled as finished goods, it can operate the program as

users commanded.

Program the downloaded or assembly finished Hex file (displayed at the bottom of the column)
in the selected IC and verify the correctness of the programming content (please refer to Chapter 4.2.1
or 4.2.2 for programming procedures).

———————— — ——————— ——————————————————————————————————————— ]
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If the selected IC is correct and the programming succeeds, message will appear at the
information column asFigure 4-20 illustrated. If “Enable Program Times” is ticked up, the enable

program times will minus 1 and the remaining program times will be revealed in the message column.

Sﬂemge

‘Program Chip OK
Program SBM OK
Verify Chip OK Show Program Times

Verify SBM 0K (If Program Times Function had been Enable)
Program Times Left HHHHHHH?/

Figure 4-20
If the IC selection is incorrect or the programming fails, a message will show up as Figure
4-21).

S Meszage

Program SBM Fail

Figure 4-21

. [
4.3.3 Verify Program
The purpose to verify program IC is to compare if the program written into IC OTP is equal to the

program downloaded to programmer or IDE Flash Memory.

Verify program IC content consistency with the downloaded or assembled Hex file (displayed at
the bottom of the column). If the IC is protected by program, this verification is ineffective or the
comparison fails.

If IC selection and program verification is success, a message will appear asFigure 4-22.

Verify Chip OK

|'1.r'eriiy SBM OK

Figure 4-22

If IC selection is incorrect or the program verification miscarries, a message will pop up as

Figure 4-23.
Werify Chip Fail

|Errur at 0x0000H

Figure 4-23

O
4.3.4Read ™
The purpose to read the IC is to verify the consistency of OTP Checksum and programmed Hex
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file. To read IC content, the procedures are illustrated as Figure 4-24. Its content will reveal at "Display

Code” window.

S HyIDE100D - Mode:[Edit] v1.08 Chip = HY - 11714 (BE) ICE Inteface = OSB Project=
File Edit Search View Programmer Option:  Windows

[ it Oe o O M &

OTP Type

s‘; Program Memory

0C01
D082 F012? D081 F010 D000 FOB5 D083 FOBC DOBO
1605 368C TFF8 3A82 3A81 3684 TFE9 000A C81D
Read Checksum = 0xFFFF 29 TFFD 000C F086 D081 F012 0601 5229 6406 1C01
2B 0601 5229 1601 3685 TFFD 000A 642A 660F 6611
85 CFB1 6483 0708 D022 F0BC DOBO F010 6483 B82B
01 3629 TFFD 700D 000C F086 D081 F012 D084 FO8D
Checksum 0OE 000C F086 D081 F012 D084 FOBD 0601 5229 6406
10 6485 5601 3629 TFFD 368C TFCF 000A 668D D010
10 648D 0708 D022 FO83 B882B 648D 5606 3629 TFFD
10 D081 F012? 3683 7801 000A 3CBD 0000 6684 CB06
03 1000 A629 6600 0630 1000 AE29 6600 O000R 668D
80 648D 0C02 3629 TFFD D080 F010 648D 0708 D022
8D 5202 3629 TFFD D080 F010 D081 F012 3683 7801
00E |D08B1 F012 /€806 C200 FOE2 D081 F012? €200 FOCE 0603 A605 1A05 0630
00F 0000 0000 0000 0000 0000 0000 0000 0000 0000 0000 0000

Figure 4-24

4.35AUTO ¥
Auto integrates the functions of Blank Check, Program and Verify. If user selects Auto, it will first

check whether the IC is blank, then to program and verify.

After the execution succeeded, a message will be displayed asFigure 4-25 displayed. If the
option, "Enable Program Times” is ticked up, the program permitted times will reduce 1 and the

remaining program times will be shown in the message column.

o Sam

S B B
Program Chip 0K
Program SBM OK

Verify Chip OK
Verify SBM OK
Figure 4-25
If any function fails, the whole process will stop and display an error message in the message
column.
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4.4 Offline Programming

4.4.1 Program Description
As the development process evolves to mass-production, the programmer can be used alone

when programming on the production line. There is not necessary to connect the programmer to the

PC.

@| vbD
@| ICESDI
@ | ICESDO
® ®| ICECS

J5

@ |VPP (8V)
@ |ICESCK
@ |ICESDI
@ |ICESDO
® VDD (3V)
® |vsSs

¢

HY-IDE

u7

USB Control Board (9 o

S2

S1

O

O

Blank
Check

Program

Ground

*

J4: Adapter 9V input.

Figure 4-26

Internal negative, external positive, supplying power source for programming (power
supply must be connected when programming OTP).

*

U7: USB port. Users use this port to connect to PC.

Download program for emulation debug.

Download program for writing HY11P series products.

*

J5 : Programming control port for HY11P series

PIN1
PIN2
PIN3
PIN4
PINS
PING

VPP (6V)
ICECK
ICESDI
ICESDO
VDD (3V)
VSS

connecting VPP of the IC
connecting PSCK of the IC
connecting PSDI of the IC
connecting PSDO of the IC
connecting VDD of the IC
connecting VSS of the IC

S1: Program, IC program button
S2 : Blank Check, IC blank check button
D4 : Double color LED;

Red LED: OTP program, Blank Check...execution error display light

Green LED: OTP program, Blank Check...execution success display light
Green LED: USB or Adapter power on display
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Figure 4-27 the control board programming pin connected way when PC is connected, downloading
program and on-line IC programming.

Figure 4-27

Figure 4-28 the control board programming pin connected way when PC is disconnected, program
download completed and off-line IC programming.

Figure 4-28

® To implement offline operation, Hex file must be firstly downloaded to programmer Flash Memory.

Please refer to Chapter 4.2.1 or 4.2.2 for procedures
®  S2 Button can check if the IC is blank. D4 green light will be lightening up after verifying.

® Sl Button is programming button. Its procedures are: Blank Check - Program - Verify.
If "Program Protection” of “Assemble Option” is ticked up before downloading data to Flash
Memory, program protection will be executed after Verify completed. If "Program Protection” is not

ticked up, D4 green light should be lightening up after programming completed.
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®  After programming completion, users can press S2 button to check if the IC is blank. At this time,

D4 red LED should be lightened up, representing program completed.

® [f any failure or error happened during execution procedures, D4 red LED will be lightened up. On

the contrary, D4 green LED will be lighted up if success.

4.4.2 Program Times Restriction
The menu of "Assemble Option” in interface setup has an option of "Enable Program Times” as

described Figure 4-2. This option restrict the times of the permitted program times of download

program.

This is a safety mechanism that restrains permitted program times, preventing it from

over-programming on the production line.

After ticking up "Enable Program Times”, key in program times in the filed below "Input Program
Times” (maximum is 99999999, minimum is 1). This argument will be written into EEPROM of the
programmer after the compiler programmed file is downloaded to Flash Memory. Afterwards, the
enabled program times will reduce 1 each time when programming completed. If the value reduced to
0, the programming action may not be executed. At this time, an error signal (red LED) will be lighted

up and Blank Check still operates normally.
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5. Revision History
Major differences are stated thereinafter:

Version Page Revision Summary
V01l ALL First edition
V03 4 Add software support: Vista & Win7
10 Add Demo Code operation way
17~19  Add program structure description and program reference document.
Add Self-defined instruction function
49 Revise program protection description

54~56  Add online programming and offline programming description
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